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Welcome to my (non-official) study notes to become Salesforce         
Certified Marketing Cloud Consultant. This document is always        
work in progress. Please feel free to submit comments to suggest           
improvements, add questions or share own experiences! 

If you need help with concrete questions and answers as they 
occur in the exam, feel free to send an  

email to ​atilla.wohllebe+SFMC@gmail.com​. 

Table of contents 
More Material 

Summary of experience, skills, knowledge and abilities needed for the certificate  

Weighting of the different areas  

Study Notes  

Discovery  

Conceptual Design  

Marketing Cloud Connect  ✓   

Account Configuration ✓  

Reporting ✓  

Data Design ✓  

Automation ✓  

Email Build ✓ 

Contact Builder ✓ 

Journey Builder ✓ 

(​✓​: This part of document is completed. Please feel free to suggest improvements!) 

 

 

By: ​Atilla Wohllebe www.atilla-wohlle.be 

mailto:atilla.wohllebe+SFMC@gmail.com
mailto:atilla.wohllebe+SFMC@gmail.com
http://www.atilla-wohlle.be/


 

More materials 
Study notes composed of: 

● Official ​Certification Exam Guide​ by ​Salesforce 

● Official ​Salesforce Marketing Cloud Documentation 

● “Deep Study Guide” by Salesforce Partner Practice Development 

Furthermore recommended: 

● “Study Notes” / “Jet Pack”​  by ​Ben Edwards​ & The Crowd 

● Miscellaneous content from ​Ben McCarthy​ / ​SalesforceBen.com 

 

If you like: I can provide you with advice regarding the exam questions and answers. 
Feel free to send an email to ​atilla.wohllebe+SFMC@gmail.com​ and we can talk,  

review & discuss the questions and answers. 
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Summary of experience, skills, knowledge and abilities needed for the 

certificate  1

● Build personalized dynamic emails (AMPscript). 

● Incorporate different tools such as segmentation, automation, tracking, and analytics 

to make data-driven decisions to optimize email campaigns. 

● Troubleshoot and solve basic platform issues. 

● Write basic SQL, including join statements. 

● Configure Contact Builder. 

● Build and activate an entry-level (simple) Journey Builder Interaction. 

● Utilize scripting for use in Email personalization (AMPscript, Guide Template, 

Language, ServerSide-Javascript). 

● Configure account setup and administration (BUs, roles and permissions, profiles, 

RMM, Users, subscriber filters, FTP). 

● Configure data (lists, data extensions, Contact Builder). 

● Manage unsubscribes. 

● Define and execute email data interactions (import, data extracts, file transfers). 

● Configure an automation via Automation Studio. 

● Configure a Triggered Send Definition. 

● Understand Web Service offerings. 

● Understand Marketing Cloud Connect. 

Weighting of the different areas in the exam  2

Discovery 13 % 
Conceptual Design 12 % 
Marketing Cloud Connect 6 % 
Account Configuration 10 % 
Reporting 7% 
Data Design 13 % 
Automation 8 % 
Email Build 6 % 
Contact Builder 14 % 
Journey Builder 11 % 

1 Official ​Certification Exam Guide​ by ​Salesforce 
2 Official ​Certification Exam Guide​ by ​Salesforce 
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Study Notes  3

Discovery 

Provided with a set of business requirements, determine what additional information 

is needed to design the recommended solution. 

 

Provided with a list of branding and creative strategies, probe for additional 

information that is needed to recommend an appropriate solution.  

There’s definitely a lot of stuff you can talk about here, but mainly this part is about one 

question: If you have a custom brand font, try to find a web-based font that looks really close 

to it - this will avoid problems displaying your text content.  

Provided a customer environment and goals, determine the viability of external 

systems that need to be included in the solution. (POS, CRM, ecommerce, data 

warehouse, data source inputs)  

 

Demonstrate how to gather requirements in order to put together the data and 

segmentation strategy for the customer. (frequency, complexity, volume of sending)  

You should have a basic understanding of metrics and kpis in online marketing. 

E. g.: 

● Increasing the amount of people you’re sending a mail to does not improve the 

engagement. 

● Good metrics and key performance indicators are conversion rates, lifetime values or 

the subscriber’s last purchase date. 

Given a scenario that includes customer information about subscriber acquisition, 

management, and attrition, utilize this information to select solution components.  

There are two relevant Marketing Cloud features to mention here: Smart Capture and Web 

Collect. 

The ​Smart Capture ​feature enables to capture lead information using landing pages or 

microsites. Marketers using Smart Capture need basic AMPscript knowledge. Smart Capture 

3 All study notes mainly based on Official ​Certification Exam Guide​ by ​Salesforce​ & Official ​Salesforce 
Marketing Cloud Documentation​ as well as  “Deep Study Guide” by Salesforce Partner Practice 
Development. 
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can update your list, Data Extensions or an integrated CRM system.  When creating a 4

custom Profile Center, Smart Capture and using AMPscript is the way to go. 

Another feature to acquire subscribers is ​Web Collect​. Web Collect allows subscription, 

attribute information and unsubscribes. Web Collect works with lists. It does not integrate 

with Data Extensions.  5

Furthermore, you should briefly know about ​Cloud Pages​: It is a SFMC application used to 

create and publish targeted marketing content to customers in a multi-channel environment. 

Content can be published on mobile, social and web - immediately or scheduled.. 

Given a solution, recommend the appropriate customer skill sets required to utilize the 

Marketing Cloud application 

 

 

  

4 ​https://help.marketingcloud.com/en/documentation/exacttarget/subscribers/smart_capture/  
5 ​https://help.marketingcloud.com/en/documentation/exacttarget/subscribers/web_collect/  
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Conceptual Design 

Analyze customer data to determine the appropriate data model. (List model, Data 

Extensions) 

A ​list​ is a compilation of subscribers that receive your communications. You create as many 

lists as you need to segment your subscribers so that you can target your email 

communications. 

Use the ​list model​ when: 

● your lists will contain 500,000 subscribers or less long-term 

● you prefer simplicity over performance 

● you do not require fast import speed 

● you plan to use a limited number of subscriber attributes 

● you use the XML API 

A ​data extension​ is a table within the application database that contains your data. You 

could use a data extension to store sendable subscriber data like Lists or just to house 

relational data. 

Use the ​data extension model​ when: 

● your lists are going to be greater than 500,000 subscribers 

● you support multiple subscriber data sets (with separate definitions) 

● you send global messages  

● you require fast import speeds 

● you implement triggered sends 

● you use the SOAP or REST APIs 

● you prefer a flexible subscription model 

Please note: Profile Center and Subscription Center do not support Data Extension. To 

achieve the same functionality, use a Custom Landing Pages and build your subscription 

center via Smart Capture or AMPscript. 
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In a given scenario, determine appropriate solution for given requirements 

considering technical expertise of personas. (Automation Studio vs. Journey Builder, 

for example)  

The ​Journey Builder​ is used to create responsive automated multi-channel campaigns: You 

can design a communication plan to reach out customers at every stage of their journey with 

your brand. 

The ​Automation Studio​ executes marketing automations (communication, data etc.) on 

immediate, triggered or scheduled basis. 

In a given narrative data flow, select the correct data flow diagram that depicts that 

data flow. 

In the exam you’ll be provided a several data flows and need to pick the right one for a 

certain task. Therefore you’ll have to understand input and output for the activities in 

Automation Studio, so you can easily exclude those flows that are technically not possible. 

Activity Input Output 

Import csv file Data Extension 

Data Extract Data Extension File on sFTP 

File Transfer Compressed file Uncompressed file 

Query  Data Extension 

 

In a given customer scenario, identify which User Stories are appropriate to use for 

accessing Marketing Cloud.  

 

In a given customer scenario, determine factors to consider when scaling the solution.  

[Missing] 

Articulate how data construct will drive one-to-one messaging and content.  

[Missing] 

Explain the purpose of IP Warming and make a recommendation based on customer 

needs 

Use IP warming to create & increase the reputation at the different ISPs for the IP 

Momentused for sending mails. A high reputation of the IP will increase deliverability. 
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For IP warming… 

● …initial sends should be spread out over multiple days by splitting subscriber list.  

● Each subscriber list should have no more than ​10,000 recipients​. 
● Send volume can be doubled every day over few weeks, as long as ​bounce rate 

below 10 %​ and ​spam complaint rate below 0.1 %​. 
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Marketing Cloud Connect ​✓ 

Understand the prerequisites to consider prior to starting a Marketing Cloud Connect 

configuration. (Salesforce edition, list of integration users, scope user, administrator 

credentials)  

The prerequisites for the Account and for the User. 

Account prerequisites: 

1. Salesforce.com Edition​ must be Unlimited, Enterprise, Performance or Person 

Account. 

● Professional Edition is not supported in MCC v5, but in v2. 

● Government Cloud requires a custom script. 

● CipherCloud is not supported. 

2. Set up one of the following ​Agency or Agency Client​ Edition: Core, Advanced, Lock 

& Publish, Enterprise 2.0, Reseller. 

● Distributed Sending is not reported. 

● On-Your-Behalf accounts are not supported. 

3. Business Rules​ for SFMC need to be set up – contact SFMC AE to enable 

Salesforce integration. 

4. Administrator​ credentials / permissions are obtained. 

5. Four ​custom tabs​ need to be available in SF. 

6. List of integration users​ needs to be compiled. 

7. Create a ​report​ that defines an intended Send To list. (Contact or Lead ID as well as 

sufficient available data storage required.) 

8. Test mail passing validation needs to be created. 

9. SFMC Connect requires a Subscriber Key. 

10. Default Sender & Delivery Profiles and Send Classifications must not be deleted or 

renamed. 

11. Automation Studio must be installed to run automations. 

12. Multiple SF Orgs​ can be connected to a MC Enterprise 2.0 multi-org account. 

13. Reports must be stored in a custom SF folder for sending and running user needs 

access to this folder. SFMC Connect does not support sending to joined reports or 

reports stored in standard SF folders. 

User prerequisites: 
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1. Users must have a ​license​ for SFMC and a license for Sales Cloud or Service Cloud. 

2. Permissions​ user must have granted: 

● Read SFMC package objects 

● Read Contacts, Leads, Campaigns, Reports 

● Read any object related to SFMC objects or standard objects. 

3. Minimum permissions​ at profile level to create API user 

● Administrative 
i. API enabled 

ii. API only user 

iii. Chatter Internal user 

iv. Password never expires 

v. Schedule reports 

vi. View Help link 

vii. View Reports in Public Folders 

● General​ ​User​ permissions 

i. Allow View knowledge 

ii. View setup & configuration 

iii. Export reports 

iv. Report Builder 

v. Run reports 

Furthermore it is essential to understand the concept of ​Scope by User and Non-Scope by 
User. 

● Scope by User 
o Reports and Campaigns visible to the user initiating the send are available for 

selection within SFMC as a target audience. 

o Subscribers are filtered based on the user initiating the send. 
o Considerations​: 

▪ Within SFMC, Report & Campaign lists are limited to what is visible by 

the user initiating the send. 

▪ Scope by User is the default behavior for SF v3 accounts. 

▪ Users must enter password during the Integrate User process. 

▪ In case of expired password, SF password must be updated on SFMC. 

● Non-Scope by User 
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o Subscribers who are visible or accessible to the Tracking User can be 

retrieved from reports or campaigns. (Tracking User often is Administrator 

within Salesforce.) 

o Subscribers are not filtered based on the user running the report. 
o Reasons​ to choose this configuration 

▪ Customer is currently using SFv2 and wants to migrate to SFv5. 

▪ Within SFMC, Report & Campaign lists are not limited to what is visible 

to the user initiating the send. 

▪ Within SFMC, returned Subscribers are not limited to only those visible 

to user initiating the send. 

▪ Passwords do not expire, so this configuration is easy to maintain. 

▪ Users can be set up without entering a password. 

o Risk​: A user could mistakenly send to Report and/or Campaign members who 

are not visible to that user without notice. 

Understand how to send an email to a contact, lead, campaign, and report via the 

Sales / Service Cloud and Marketing Cloud. (sending, triggered, automated) 

SENDING MAILS IN SALESFORCE 
There’re ​two types​ of sending mails:  

1. Single sends to Leads, Contacts and Person Account records  

2. sends to a list from Campaigns and Salesforce reports. 

To ​Single Send Marketing Cloud Email​ choose a record (e. g. a lead) to send the email to. 

Mail from Marketing Cloud can be chosen and previewed. The ​From email address​ is based 

on User Logged In OR Record Owner OR Organization-wide Email Addresses. Alternatively 

choose a SFMC Send Classification. 

To ​Send to a list​, go to Marketing Cloud tab, (prn select business unit,) and choose an email 

from My Emails or Shared Items. Choose one or more Reports and / or Campaigns as 

recipients. To save the audience for future sends, click “​Remember recipients and 
exclusions for this email​”. Choose Send Classification and Reply-To email address, select 

“Dedupe Subscriber” to prevent duplicates (Case: Two contacts with the same email address 

– only first contact will receive the mail). 

SENDING MAILS IN SALESFORCE MARKETING CLOUD 

The Salesforce Marketing Cloud can be used to send classic email content and content from 

Content Builder to send emails to Salesforce… 
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● reports 

● campaigns 

● SFDEs 

● shared SFDEs. 

Therefore ​Send Flow​, ​Guided Send​ (on an existing mail) and Salesforce Sends can be used. 

Salesforce Sends is described here: 

1. Within SFMC open Email Studio → Email → Interactions 

2. Choose Salesforce Send Emails and create content. 

3. As recipients, Salesforce reports / campaigns / DEs / shared DEs can be included or 

excluded from the send. 

TRIGGERED SENDS WITH SFMC CONNECT 

What it does… 

Create and send triggered emails via SFMC within SF Sales and Service Cloud when an 

object is created or updated. Aggregate tracking data for Triggered Sends is viewable from 

SF Sales and Service Cloud. 

Email addresses / contacts receiving a triggered send are added to a destination data 

extension. As a fallback (no destination data extension defined) the contact will be added to 

All Subscribers List – note: If the user activating the triggered send does not have access to 

All Subscribers, the subscriber is not added to that list. 

What the prerequisites are… 

● The object must have a Contact ID or Lead ID. (Account objects will not work.) 

● Triggered sends always require an insert or update event. 

● The email to send must pass the validation within SFMC. 

● The maximum number of field criteria is ten (10). 

● Triggered Sends must be enabled in SFMC. 

● A Send Classification is required but From name / From address can be overwritten 

manually. 

● Editing an existing Triggered Send requires deactivating it before. 

● Bulk updates and inserts are not supported by Triggered Sends. (Breaking bulks into 

batches with maximum of 50 records may be required.) 
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● Modifying Apex in the user interface is only possible for Developer Edition, Sandbox 

and Trial organizations. (Unlimited and Enterprise Editions can only view and execute 

Apex within user interface.) 

How to configure it… 

1. Click Setup → Customize → Desired Object → Triggers → New, select Is Active and 

enter code. Then click Save. 

2. Configure Integration Page via Marketing Cloud Tab → Configure MC Connect → 

Edit → Triggered Sends → set Restrictions → Select enabled objects → Add. Then 

click Save. 

The tracking data for Triggered Sends will populate on Individual Email Result related list on 

the Contact or Lead record and on the Triggered Send Definition (Aggregate Link Level 

Details). 

How to create a Triggered Send… 

To create a Triggered Send, navigate to the Marketing Cloud tab, choose Triggered Sends. 

Then select Object to create the Triggered Send for and choose Recipient Source, e. g. 

Contact ID or Lead ID. 

Possible triggers are: 

● New record created 

● Existing record updated 

● New record created or existing record updated 

● New record created or existing record updated to subsequently meet criteria. 

The maximum number of criteria is ten (10). 

How to personalize based on Custom Objects… 

You can use Custom Objects and AMPScript associated to a Contact or Lead to personalize 

the Triggered Sends. 

Understand how Sales / Service Cloud data in the Marketing Cloud can be segmented. 

Use ​Salesforce Data Extensions​ to push tracking data back to Sales or Service Cloud 

Orgs. Segmentation and filtering tools for SFDEs are the same as for classical Marketing 

Cloud Data Extensions. 
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Tracking data for emails sent to SFDE audiences using Send-feature of SFMC can be 

pushed back to SF Contact or Lead records within the connected Org. 
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Account Configuration ​✓ 

Given a customer scenario, recommend the appropriate Marketing Cloud role based 

on User Stories.  

There are ​five roles​ in SFMC: 

● Marketing Cloud ​Administrator​ - a person in this role assigns Marketing Cloud roles 

to user and manages Mobile, Social, and Sites Channels, Marketing Cloud Apps, and 

Marketing Cloud Tools 

● Marketing Cloud ​Viewer​ - a person in this role views cross-channel marketing activity 

that results in the Marketing Cloud 

● Marketing Cloud ​Channel​ ​Manager​ - a person in this role creates and executes 

cross-channel interactive marketing campaigns and administers Social and Mobile 

Channels 

● Marketing Cloud ​Security Administrator​ - a person in this role maintains Watchdog 

security settings and manages user activity and alerts 

● Marketing Cloud ​Content Editor/Publisher​ - a person in this role creates and 

delivers messages through Mobile and Sites Channel Apps 

To ​customize roles & troubleshooting​: 

1. Which features will the customer use? 

2. Which individual permissions does the customer need? 

3. Which permissions should be restricted? 

4. Assign role(s) and check permissions & restrictions working correctly! 

As a ​general principle​, every user should have just as many permissions as necessary to 

perform their tasks. 

Determine which type of customer scenario warrants the creation of a business unit. 

(publication types, demographic, workflow processes, organizational structure)  

A business unit is a ​hierarchical administrative structure​ that controls access to 

information and sharing of information. A business unit allows you to manage ​user roles​ for 

the business unit, view users who have access to the business unit, and define filter criteria 

for subscribers. 
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All items created in a business unit are accessible to all users working in that business unit. 

Items can be shared with other users in other business units by placing them into a ​shared 
items ​folder, located in the Content and Subscribers sections of the applications. 

Business units manage the ​visibility of data​ within an account using a hierarchical structure, 

which can be organized in any way to match your business needs. Business units can mirror 

workflow processes, demographic and behavioral data about your subscribers, or your 

organization's operational structure. 

Example for a three-level business unit structure: 

● Top-level (parent) business unit covers brand, e. g. templates and styles. 

● Second-level business units (e. g. divisions) control content and type of 

correspondence. 

● Third-level business units (e. g. regions) control subscription lists and personalization. 

In a given scenario, troubleshoot issues regarding Reply Mail Management (RMM).  

RMM is part of the Sender Authentication Package (SAP) and helps marketers managing 

replies automatically. RMM therefore uses Match-Action rules to determine whether an email 

is an out-of-office reply, auto-reply or an unsubscribe request. You can also do the following: 

● Forward an email to different users depending on different circumstances. 

● Conditionally auto-reply and control the content of that auto-reply message 

RMM is ​configured in the Admin tab of SFMC​. To configure RMM, set Email Display 

Name, Reply Subdomain, Email Reply Address, DNS Record Redirect Complete. 

Following ​rules of RMM​ are applied to replies: 

● Delete auto-replies and out-of-office replies​ (checking header, subject line, from 

address and first 200 chars of email body for specific terms – e. g. “autoresponse”, 

“out on vacation”, “new email address”) 

● Unsubscribe manual requests​ (same as rule before, select terms manually) 

Attention RMM will unsubscribe for the entire account. To handle unsubscribes on list-level, 

use Enterprise-RMM. 

Furthermore, reply mails can be forwarded automatically with ​Auto-Forward 

● to a user from multi-connect From list 

● to a user-defined name / email address. 
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(Notes: Some personalization string (AMPscript) are enables; Auto-Forward updates To 

information but retains From email header information.) 

Analyze the impact of applying Sender Authentication Package (SAP) to a business 

unit. (link wrapping, landing pages, image URLs) 

The SAP helps subscribers to identify the customers brand and increases the brand 

awareness. It also increases deliverability. SAP can be bought from Salesforce relationship 

manager. 

● Private Domain​ will assign a domain used to send emails as a From address. SFMC 

will authenticate email sends using SPF, Sender ID, DomainKeys / DKIM 

authentication. 

● Account Branding​ modifies link and image wrapping so that all reference zo SFMC 

are removed from sendings in favor of the authenticated domain. 

● Dedicated IP Address​ assigns a unique IP address to an account. This IP address 

represents the majority of the sender’s reputation. 

 

  

 

By: ​Atilla Wohllebe www.atilla-wohlle.be 

mailto:atilla.wohllebe+SFMC@gmail.com
http://www.atilla-wohlle.be/


 

Reporting ​✓ 

Explain how the information in data views and tracking extracts are accessed.  

Tracking extracts​ can be exported to a CSV file or populated into Data Extensions. 

Data Views​ are the list of standard (backend) data tables, e. g. “Subscribers”, “Sent”, 

“ListSubscribers”, “Job”, “SurveyResponse”. 

Data Views are accessed by Queries using SQL-like statements. To create a Query Activity, 

go to Interactions → Query → Create. Define the Query, select the Data Extension to 

populate the Data and select the type (update, overwrite, append). 

Compare and contrast standard reports, data views, and tracking extracts.  

Standard Reports​ can be run manually or as an activity, run in flow / out of flow and be 

delivered by mail or ftp. (Export e. g. as csv, xls, pdf, xml.) 

Data views​ allow to query the database for specific standard backend tables. 

Tracking Extracts​ provide granular data to use in an external program. 

Summarize Send Logs including when/why to use it; how to create and manage 

Send Logs ​provide access​ to data not available via the standard tracing function in SFMC 

application. The data contains information about email send attributes for use in reports & 

data extracts. 

To ​use Send Logs​, first create a Data Extension using send logging template. Besides 

standard fields, additional information can be store in that DE. Important: The names of the 

columns in the Send Log DE must exactly match the names of the attributes / fields in the 

sendable DE. Send Logs can be accessed by Query Activities – usage of measures, filters 

and automation studio on the DE to segment is possible. To determine in which context 

content is displayed use AMPScript. 
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Data Design ​✓ 

Explain the various data objects in the Marketing Cloud. (data extensions, list model, 

data retention model, publication lists, suppression lists)  

A ​list​ is a compilation of subscribers that receive your communications. You create as many 

lists as you need to segment your subscribers so that you can target your email 

communications. (Use cases: Less than 500,000 subscribers, simplicity needed, import 

speed not important, XML API is use, limited number of attributes) 

A ​data extension​ is a table within the application database that contains your data. You 

could use a data extension to store sendable subscriber data like Lists or just to house 

relational data. (Use cases: More than 500,000 subscribers, multiple data sets, global 

messages, fast import required, Triggered Sends in use, SOAP / REST API in use) 

A ​publication list​ helps managing categories of content subscribers receive – e. g. one 

publication list for newsletters, one for advertisements and one for alerts. With publication 

lists, advertisers can create an opt-down strategy for customers.  Publication lists work for 6

the channels email and SMS.  7

An ​exclusion list​ is any list, group or data extension containing subscribers to be excluded 

from a send by Subscriber Key (if enabled for account) or email address. 

Data retention​ policy helps managing data in SFMC by deleting unused data from Data 

Extensions after a certain time (standard: 6 months, can be modified). This will not affect 

Subscriber data but only Data Extension data. Note: Data retention policy is to be specified 

when creating the DE and cannot be modified for existing DEs. 

Data can be deleted by several Data Retention options:  

● Use Object-Based Retention​ - Checking this box ensures that the application 

deletes all records in the data extension at the same time. 

● Retention Period​ - Enter the number of days after data extension creation to wait 

before deleting data. 

● Use Fixed Date​ - Check this box and specify the date to delete data extension 

information after that date. 

● Delete at End of Retention Period​ - Check this box to retain the data extension but 

delete the records inside that data extension. 

6 Thanks to Ahmed Saad! 
7 The concept of publication lists is explained in the official documentation ​here​ (incl. good figure). 
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● Reset Retention Period on Import​ - Check this box to extend the retention date 

following a new import to the data extension. 

Use 
Object-Based 

Retention 

Delete at End of 
Retention Period 

Results 

Not selected Not selected 
Unused data extensions deleted by 

default after 6 months 

Selected Not selected 

Both the data extension and data are 

deleted at the time specified by the 

retention period settings 

Selected Selected 

The data extension remains, but the 

data itself is deleted at the time specified 

by the retention period settings 

 

Understand available data types, retention and template options when building a data 

extension.  

List of data types​ available in SFMC: Text, Number, Date, Boolean, Email, Phone, Decimal, 

Locale. 

Data retention ​is explained above. 

To ​Create a Data Extension with a Template​, select Subscriber → Data Extensions → My 

Data Extensions and click “Create from Template” button, then choose Template. There’s a 

small number of standard Data Extension Templates within SFMC for certain use cases. 

Understand how data is retrieved within a Relational Data Model. (basic SQL)  

Use SQL to create a Query with Query Activity and retrieve data from Data Extensions. 

Best Practices for Data Extensions and Query Activities: 

● Choose correct Data Field types and appropriate Field Lengths. 

● Limit the number of columns for a Data Extensions to 255. 

● If deleting columns and observing performance issues, consider setting up the Data 

Extension from scratch again. 
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● Write efficient Queries and avoid non-searchable operators in WHERE clause (OR, 

NOT, <, >, NOT IN, NOT LIKE, NOT EXISTS, intrinsic functions). 

Different types of the JOIN within SQL: 

● INNER JOIN  

● FULL OUTER JOIN  

● LEFT OUTER JOIN  

● FULL OUTER JOIN  

with including only results WHERE TableA.column OR TableB.column is NULL. 
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Given a customer scenario, recommend appropriate import method with list or data 

extensions.  

Lists only support importing files. Data Extensions additionally support SQL Queries. Both 

(DEs and Lists) can be updated via API. 

Understand the implications of a system being database of record. 

The “database of record” is a repository for centralized storage of information about objects 

or people. Normally this is SFMC or might be, if integrated into SFMC, CRM or ERP. 

The database of record should always be up to date – integrations therefore should work 

bi-directional. 
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Automation ​✓ 

Given a customer scenario, select the appropriate workflow that meets the business 

requirement. (import, segmentation, email send)  

● Use ​import​ File Activity to update a subscriber list or DE using an external file. To 

handle encrypted or compressed files, use a File Transfer Activity. Enabling encoding 

will apply to all imports for an account. Note that SFMC assumes FTP server report 

time is UTC. 

● For ​segmentation​ use a Query Activity (querying Data Views) or a Filter Activity 

(filtering a List or DE). Filtering a List results in a Group, filtering a DE results in a new 

DE. You can also use a measure within a filter. 

● For an ​email send​, use the Send Email Activity. 

Compare and contrast triggered and scheduled interactions 

A triggered automation initiates e. g. when a file is dropped into an Enhanced FTP folder. 

Only changing filenames without changing the content will not trigger the automation. 

A scheduled automation runs when scheduled or when clicking “Run Once”. Typical use 

case is a birthday list to be refreshed. 
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Email Build ​✓ 

Understand the required steps to build, test, and deploy an email based on customer 

requirements.  

To ​build an email​, use 

● Template​ - does not require any HTML skills 

● HTML Paste​ - requires HTML skills and allows a simple copy and paste of HTML 

code into the editor 

To individualize email content, use personalization strings or dynamic content, implemented 

with AMPscript or (server-side) JavaScript. (see following sections) 

To ​test an email​ use 

● Content Detective ​- checking email for spam triggers 

● Email Validator ​- checking email for unsubscribe link, physical mailing address, 

syntax, content rules 

● Send Preview​ - rendering the email as it will be sent to a recipient with the possibility 

to preview mail for each subscriber on the list 

● Subscriber Preview​ - a rendering of an email as it will be viewed by a recipient 

● Test Send​ - test send to see how an email displays in an actual client 

To ​send an email​ use 

● Send Flow​ - replaces Guided Send for Content Builder emails 

● Guided Send​ - guides the user through all the necessary steps to send an email 

● Simple Send​ - quick way with limited options  8

● Simple Automated Send​ - quick way to set up a single-step-once-a-year-automated 

email 

● User-Initiated Send​ - sends a mail as part of a program  9

● Triggered Send​ - as a response to a subscriber's action 

● Journey Builder ​- email send as part of a journey within the Journey Builder feature 

8 ​http://help.marketingcloud.com/en/documentation/exacttarget/content/send_an_email/  
9 ​http://help.marketingcloud.com/en/documentation/exacttarget/content/send_an_email/  
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Explain the various ways to individualize email content. (AMPscript, personalization 

strings, dynamic content, guide template language)  

There’re several ways to individualize email content. 

● Personalization strings​ are an easy way to insert (profile and preference) attributes 

from your account into emails and can be used in the subject line or in the email’s 

content boxes.  

Note: Personalization strings... 

○ ...are case-sensitive, 

○ …have two % symbols on both sides, 

○ ...do not have a standard fallback option, if the string is not available. 

● AMPscript​ is the scripting language in the Salesforce universe and can be 

emdedded in emails, landing pages, SMS and push notifications. 

Note: AMPscript… 

○ ... calls are handled at the end of an email send, 

○ ... can also interact with DEs, 

○ ...includes functions… 

■ ...to work with relational data, 

■ ...to display metadata about data, 

■ ...to provide control logic and can store information as variables and 

use them, 

■ ...to format values / data types, 

■ ...to track impressions of regions within an email. 

● Dynamic content​ are content boxes displaying according to defined rules within 

SFMC based on the attributes of the subscribers. Using dynamic content is possible 

for every type of email (except text-based emails) and requires content boxes. 

● The ​guide template language​ provides a declarative syntax to create personalized 

and dynamic messages and to build cross-channel templates and layouts. It is 

typically used by designer, developers and technical marketers in the context of 

Journey messages. 

Compare and contrast the ways to individualize content, such as: SSJS vs AMPscript, 

Dynamic Content Wizard vs. AMPscript/LookupRows function.  

Server-Side JavaScript​ allows using arrays and advanced exception handling. Compared to 

SSJS, ​AMPscript ​allows efficient inline personalization, simple IF ELSE statements, better 

subscriber-individual unique content and is easy-to-learn. 
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The ​Dynamic Content Wizard​ offers predefined content elements displayed based on the 

value of a specific field for a specific recipient. The ​AMPscript Lookup Rows​ fetch dynamic 

content from a data extension based on the attribute that serves as the key value. 

Explain various Marketing Cloud Email technologies. (Link Alias tags, Impression 

regions, Web Analytics Connector) 

The ​Link Alias Tag​ displays in report instead of the URL to give more meaningful names. 

The Link Alias Tag can also be used in case single urls are used multiple times in the email. 

To use the Link Alias Tag type ​<a alias=”:Logo_hello_world”>​. 

Impression regions ​allow to track performance of emails containing content built by 

AMPscript or selected by the dynamic content feature. Each region is given a unique 

identifier which can be used to track, segment and report. 

The ​Web Analytics Connector ​passes information from email messages to a web analytics 

tool, e. g. Google Analytics or WebTrends. Therefore the Web Analytics Connector includes 

variables in the target URL of the links allowing collection of data of five levels: Account, 

email, campaign, subscriber & link level. 
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Contact Builder 

Explain the role and capabilities within Contact Builder. (tools such as data designer, 

all contacts, data extensions, imports, data sources, contact configuration) 

Contact Builder helps marketers to consolidate and organize data and allows linking 

customer data back to original data records, stored in systems as ERP, CRM etc. Providing a 

single view of all customers, Contact Builder assists in personalizing customer conversations 

across all channels and on every device. 

Tools: 

● Contacts Configuration - determine how to process imported contact information 

● Data Designer - define information about contacts and relate data to contacts by 

linking data extensions 

● Data Extensions - create and manage everything about data extensions 

● Imports - create processes manage (scheduled) imports 

● Data Sources - visualize the sources of data and attributes used 

Understand how cardinality and root relationships impact data modeling.  

When creating a relationship between two data extensions, the ​cardinality​ needs to be 

specified. Analogous to a database, SFMC knows three different cardinalities: 1:1, 1:n, n:m. 

A ​root relationship​ is a special case of a 1:1 cardinality: It is a one-to-one relationship 

between a contact record and a data extension that acts as a source for contact information. 

A root relationship can only take place between a contact record and a single data extension. 

(Root relationships have been replaced by ‘populations’ ) 10

Please note: If the relationship between a contact record and a data extension is changed, then 

filtered lists based on information from that data extension won’t have access to that information 

anymore. 

Summarize how to use Data Designer to incorporate data source into Contact Builder.  

[Missing / Community input needed: What does the official study guide want me to 
write here?] 

Data Designer is used to define, consolidate and organize customer data. It manages how 

data extensions store information and how they relate to each other. 

10 ​http://help.marketingcloud.com/en/documentation/contact_builder/data_designer/#RootRelationship  
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Data Sources can be divided into three types depending on their locations: 

● System ​data source: Representing data structure created by default within the 

SFMC, including entries for Marketing Cloud, Email Studio, Mobile applications, 

Predictive Intelligence etc. 

● Synchronized​ data source: Data from external sources imported via Data Stream / 

using the Salesforce Marketing Cloud Connector feature. 

● Custom​ data source: Collecting attributes used with Contact Builder and visually link 

those attributes to a specific data source, which identifies where the values originate. 

Given a customer scenario, know how to build an Attribute Group to be used for a 

simple interaction. 

An Attribute Group collects several data extensions into a single entity, so each attribute 

group can contain multiple data extensions, each including multiple attributes. Data 

Extensions can be linked to the contact record or different Data Extensions, including Data 

Extensions from other Attribute Groups. 

The underlying idea seems to be that, sometimes you may have several data extensions 

regarding a specific topic (e.g. flight information). To maintain an overview of these DEs, you 

can group them together as “attribute groups”.  11

[Missing: Add more input here!] 

 

  

11 
http://help.marketingcloud.com/en/documentation/contact_builder/getting_started_with_contact_builder/create_attribute_group/  
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Journey Builder 

Compare and contrast the automation tools, such as Journey Builder, Automation 

Studio, and Pardot.  

● Journey Builder: Responsive multi-channel campaigns designed on a canvas, 

perfectly managing the communication plan how individuals interact with your brand. 

● Automation Studio: Immediate, triggered or scheduled marketing automations, mainly 

to process data. 

● Pardot: B2B marketing automation and lead nurturing, completely separated from 

SFMC. 

Given a customer scenario that includes Journey Builder, evaluate the requirements, 

activities, and steps.  

[Missing] 

Explain the requirements for and the methods by which a contact can enter a Journey. 

● Salesforce object created or updated 

● Fire Event using API 

● Fire Event using Automation Studio 

● Journey scheduled Fire Event 

Entry Events can be... 

● Interaction-specific: Configured within an Interaction, only be used by that Interaction. 

● Shared: Created in event administration, may be selected for use in multiple 

interactions. 
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